Final Cut Pro
Shared & Remote Solutions 2021
Section Outline

Introduction
The reasons for writing (and rewriting) this paper; who it’s for and what’s changed since the original.

Chapter One
Understanding and Managing Media and Libraries in Final Cut Pro.
An essential primer for understanding the tools and workflows in the rest of this paper.

Chapter Two

Chapter Three
Third Party Collaborative Workflows in Final Cut Pro.
Some of the third party solutions that complement and advance Final Cut Pro further.
# Final Cut Pro
## Shared & Remote Solutions 2021

## Table Of Contents

<table>
<thead>
<tr>
<th>Section Outline</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Of Contents</td>
<td>3</td>
</tr>
<tr>
<td>Introduction</td>
<td>5</td>
</tr>
<tr>
<td>Chapter One - Media and Storage Fundamentals</td>
<td>6</td>
</tr>
<tr>
<td>The Basics - Libraries, Events, Projects</td>
<td>6</td>
</tr>
<tr>
<td>Workflow Fundamentals</td>
<td>9</td>
</tr>
<tr>
<td>Library and File Placement</td>
<td>10</td>
</tr>
<tr>
<td>Workflow Set-Up</td>
<td>11</td>
</tr>
<tr>
<td>Importing - Copy to or Leave files in place?</td>
<td>14</td>
</tr>
<tr>
<td>Managed vs External Media</td>
<td>15</td>
</tr>
<tr>
<td>Library and Media Storage Options - Single User</td>
<td>16</td>
</tr>
<tr>
<td>Importing Strategies</td>
<td>17</td>
</tr>
<tr>
<td>System Performance</td>
<td>19</td>
</tr>
<tr>
<td>Cache Files</td>
<td>20</td>
</tr>
<tr>
<td>Optimized Files</td>
<td>21</td>
</tr>
<tr>
<td>Proxy Files</td>
<td>22</td>
</tr>
<tr>
<td>Comparing Sizes: Original, Optimized and Proxy</td>
<td>23</td>
</tr>
<tr>
<td>Chapter 2 - Sharing Work in Final Cut Pro</td>
<td>25</td>
</tr>
<tr>
<td>The Tools - Copy</td>
<td>26</td>
</tr>
<tr>
<td>The Tools - Move</td>
<td>29</td>
</tr>
<tr>
<td>The Tools - Relink</td>
<td>29</td>
</tr>
<tr>
<td>The Tools - Consolidate</td>
<td>30</td>
</tr>
<tr>
<td>The Tools - Merge events</td>
<td>31</td>
</tr>
<tr>
<td>The Tools - XML</td>
<td>32</td>
</tr>
<tr>
<td>The Tools - The Transfer library</td>
<td>33</td>
</tr>
<tr>
<td>The Ultimate Transfer Library</td>
<td>34</td>
</tr>
<tr>
<td>The Tools - Proxy-Only Library</td>
<td>35</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Shared Media</td>
<td>37</td>
</tr>
<tr>
<td>Shared Media Example 1: Programme Stitch</td>
<td>38</td>
</tr>
<tr>
<td>Shared Media Example 2: Logging</td>
<td>39</td>
</tr>
<tr>
<td>Shared Media Example 3: Live logging</td>
<td>40</td>
</tr>
<tr>
<td>Shared Media Example 4: Breaking Down Work</td>
<td>41</td>
</tr>
<tr>
<td>Shared Library Storage Options</td>
<td>42</td>
</tr>
<tr>
<td>Cloud-Based Media</td>
<td>44</td>
</tr>
<tr>
<td>Remote Media</td>
<td>45</td>
</tr>
<tr>
<td>Remote Media - Physical Drive Clone</td>
<td>46</td>
</tr>
<tr>
<td>Remote Media - Physical Drive - Library Clone</td>
<td>47</td>
</tr>
<tr>
<td>Remote Media - Upload/Download</td>
<td>48</td>
</tr>
<tr>
<td>Remote Media - Cloud Syncing</td>
<td>49</td>
</tr>
<tr>
<td>Remote Media - Using iCloud Drive</td>
<td>50</td>
</tr>
<tr>
<td>Remote Media - Extra Media</td>
<td>50</td>
</tr>
<tr>
<td>Remote Media - Hybrid Proxy/Physical Drive</td>
<td>51</td>
</tr>
<tr>
<td>Remote Media - Reconnect to Original Media</td>
<td>52</td>
</tr>
<tr>
<td>Chapter 3 - Remote Working: Third Party Solutions</td>
<td>53</td>
</tr>
<tr>
<td>Frame.io and Final Cut Pro</td>
<td>53</td>
</tr>
<tr>
<td>Postlab and Final Cut Pro</td>
<td>60</td>
</tr>
<tr>
<td>Postlab Drive</td>
<td>63</td>
</tr>
<tr>
<td>XML Workflows</td>
<td>64</td>
</tr>
<tr>
<td>About the author</td>
<td>66</td>
</tr>
</tbody>
</table>
Introduction

I wrote the first version of this paper in 2013 with my good friends at 10dot1 in London to coincide with the release of Final Cut Pro X 10.1 which introduced the Library model. Since then, Final Cut Pro has advanced considerably with perhaps the biggest improvement, the actual performance of the software with new hardware developments offering another massive speed bump. Final Cut Pro is now buttery smooth if you get your workflows and set-up right.

Whether cutting a feature or a YouTube vlog, Final Cut Pro is the same software. Techniques vary widely however, depending on the nature of your job; one of the trickiest parts is choosing your path through this jungle and early mistakes can haunt you. This paper will hopefully help you navigate that jungle in terms of workflow.

8K, RAW, HDR, 360, VR; Final Cut Pro performance is exceptional, however, in 2020, one need has overshadowed everything - shared and remote working. With these aims, this technical paper starts with understanding media management in Chapter One and then discusses shared and then remote working in Chapter Two with a look at third party integrations in Chapter Three.

Who is this for?

This paper is intended for seasoned and new users of Final Cut Pro, both technical and non-technical so I hope I’ve found the right balance of clarity and brevity.

This paper should benefit you if:

- You are at the beginning of a job, choosing hardware as well as workflow.
- You are planning and optimising workflow around existing hardware.
- You are encountering problems with existing workflow.

Hopefully this will help you make the right choices. One word of warning: every workflow is unique and nuanced, so everything here is hypothetical example only - intended as guidance not absolute truth.

This is a long read but hopefully worthwhile. In the interests of keeping things short, timeline editing is not discussed whatsoever; neither are media asset management, archive solutions or specific hardware recommendations.

Good luck and I hope this helps.
Chapter One - Media and Storage Fundamentals

The Basics - Libraries, Events, Projects

There are three essential elements to any workflow in Final Cut Pro. The simplest way to work is have one of each: one library, one event and one project.

Libraries

Libraries are the essential working database in Final Cut Pro. Everything happens within a library; they are the top of the pyramid and manage your creative work and your media.

Right off the bat, let us say that having your working library in an optimum location is going to be one of the key factors in determining the responsiveness of your system.

Inside Final Cut Pro, Libraries have a more muted icon (as seen with this “FYG Summer Recap” to the left.

Along with every new library, you get a set of Smart Collections and one event (on the left the even is called 12-08-2020).

A library is a self-contained unit. All assets in an event or project must reside in the same library (but can be added from another library). The simplest way to work is with one library per job as everything is managed inside that one library, however for complex work (such as a series), you may fare better with more than one library so you can divide work into sections. Having more than one library open at the same time uses up computer resources, so avoid if possible; that being said, the majority of Chapter 2 on shared and remote working involves opening two or more libraries to facilitate sharing.
Events

Events are storage containers for assets within Final Cut Pro; like Libraries they are database driven. If you are coming from another NLE, events are the closest thing you’ll get to a bin, but with many more functions and flexibility.

Events are where you import, log, organise, view and prepare clips for editing. At Finder level, events are hidden inside libraries - they are visible only within Final Cut Pro.

Naming events

When first created, events are given a “current date” name, however they are not date dependent in any way. Name events whatever works for your job: scene, location, person, place. On bigger jobs, create a clear system that works for everyone as events are key to sharing work.

Projects

A project in Final Cut Pro is a sequence. Nothing more, nothing less.

A project is what you edit in the timeline and output. Projects are created from audio and video, still images, titles, other graphics and captions. Projects are stored in events.

Inside Final Cut Pro, projects are represented by the clapperboard icon.

This shows a project in the Final Cut Pro browser (in filmstrip view) called “DriveBy” with creation date, time and duration 1’27”07.

The majority of the time, it will be projects that you see open in your timeline, however there are two other important items you can also open in the timeline; Multicam clips and Compound clips. These can both be present within a project and it is vital when media managing to understand their relationships.

To avoid any confusion this is the only use of the word “Project” in this paper. To describe an overall task (or production), we exclusively use the word “Job”.

<table>
<thead>
<tr>
<th>Name</th>
<th>Start</th>
<th>End</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Projects</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DriveBy</td>
<td>00:00:00:00</td>
<td>00:01:27:07</td>
<td>00:01:27:07</td>
</tr>
<tr>
<td>Clips</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Music</td>
<td>00:00:00:00</td>
<td>00:06:48:41</td>
<td></td>
</tr>
<tr>
<td>Still Frame</td>
<td>01:00:10:00</td>
<td>00:00:10:00</td>
<td></td>
</tr>
<tr>
<td>Clip0001</td>
<td>00:00:00:00</td>
<td>00:01:27:07</td>
<td>00:01:27:07</td>
</tr>
<tr>
<td>Used</td>
<td>00:00:00:00</td>
<td>00:01:27:07</td>
<td>00:01:27:07</td>
</tr>
</tbody>
</table>
Files & Clips
The distinction between files and clips is helpful to understand. Importing files into Final Cut Pro produces clips. Clips are virtual representations of files inside of Final Cut Pro. You will not see clips outside Final Cut Pro and you will not see files inside it.

When imported, a file in the finder becomes a clip in Final Cut Pro.

Packages
For a full appreciation of the workings of Final Cut Pro, it is important to understand that libraries (and caches) are not just single files, they are packages - bundles of multiple items wrapped up together in a specific hierarchy; the structure of which FCPX relies on staying intact. Final Cut Pro library packages contain files, caches, databases, metadata and references to your media (and sometimes your actual media), however you will not see any of these in the Finder as they are wrapped up and hidden in the package.

When Final Cut Pro is open, databases are being constantly accessed and the associated data is made up of very small files; these two facts mean that Final Cut Pro libraries require fast storage in order to function most efficiently, however there are different types of “fast” storage and what functions well for large media files does not necessarily work well with the tiny files contained within a Final Cut Pro library or cache. For more about and how Final Cut Pro works best with storage see chapter 2, page 43.
Workflow Fundamentals

Libraries are independent
All clips in any project or event must reside in the same library. This concept is absolutely fundamental to Final Cut Pro workflow. A library can be used to combine any number of clips from single or multiple events into single or multiple projects. Any number of clip formats can be imported and combined and a library can contain and output multiple project formats, frame rates and resolutions.

Working with more than one library
Final Cut Pro can work with more than one library, allowing transfer of assets across libraries; e.g. copying selected clips from an archive or a project (sequence) from another editor. Transferring assets across libraries is one of the key concepts of sharing and is dealt with later in this paper (Chapter 2).
Library and File Placement

I’ve seen some terrible Final Cut Pro set-ups, even in larger companies and I’ve seen workflow advice that has cost productions thousands of dollars. The majority of this has involved people placing media and libraries into inappropriate locations for optimum performance.

Optimum media and library locations will often differ due to fundamentally differing behaviours. There are some rules but rarely one “right” answer. A better approach is holistic, taking in the myriad of parameters that need to be considered. We give simple answers below and more complex discussion in Chapter 2.

Where do I save my working Final Cut Pro library? The simple answer.

When you create a library you need to choose a storage location for it. The default is your Movies folder, however you can place it in many locations; your Mac, attached hard drives (local and shared), some networks and even cloud-based virtual drives. So where should it be?

You should always have your library in the optimum location however as mentioned earlier, libraries behave very differently to large media files and what you may think is your fastest media storage may well not be optimum for your Final Cut Pro library. Complex (and expensive) storage systems advertising huge media read/write speeds may actually hinder library performance. For simple libraries, this may not be such an issue but the more complex your library becomes, the more noticeable this will be.

So a simple answer is get your library on an SSD. This may be internal or external. If you have a modern Mac with PCIe-attached flash (SSD) storage, this is almost certainly going to be the best place for your library. If your start-up drive is not an SSD (ie a spinning or even a fusion drive), an external SSD with a fast connection may well give better results.

Some people may argue that storing a library on a system drive (running MacOS and Final Cut Pro) is not clever (and a few years ago this might have been true), however current internal speeds should overcome any extra overhead.

Where do I save my media? The simple answer.

The simple answer is your fastest storage with the fastest connectivity, however you will also need enough space and your fastest location may not afford you the space needed.

For single-user workflows, local SSDs in some form, will probably be your best bet, especially if your total media is going be less than a few TB. Be aware single drives offer no safety net in case of failure. For more protection and larger media pools, consider something RAID-striped which offers redundancy (protection) and speed, or alternatively use a cloud back-up.

Personally, on any jobs less than 2TB, I use my older RAID-striped arrays as back-up storage (running ChronoSync or something similar) and SSDs as the main media drives; SSDs not only afford speed and space but also no whirring fan noise and little heat.

See page 42 for a discussion on the merits of shared media storage types comparing DAS, SAN and NAS.
Workflow Set-Up

Importing
How you import files is absolutely vital to the understanding and success of your workflow and is covered briefly here in terms of media management only. Note the distinction between clips and files in the menus.

This first section determines where your clips will be created within Final Cut Pro. (ie what event and if a new event, what library).

This section shows whether files will be copied or linked to and where they will be saved on your drive; in this case the files will be copied to the Final Cut Pro library. File storage location is actually controlled by the Library Properties menu (see below).

This section controls what extra files are generated on import in addition to the original files. Proxy workflow options now offer incredible flexibility and will be prompted upon clicking “Create Proxy”.

A key choice missing from the above import dialogue is the storage location of your imported files which should be set in Library Properties before you come to this dialogue.
Library Properties

Media file location is controlled in the Library Properties pane in the Inspector (accessed by selecting a library). This is key to most media management in Final Cut Pro; it determines where any new media will be created (on Import) and also where any media is copied, moved or consolidated.

Modify - changes the working color space of the library (not relevant to this paper).

Modify Settings brings up the Set Storage Locations menu (see next page).

There are four storage locations (in the red box) detailed on the next page.

Storage Used shows the current file size of all media associated with this library, broken down into Original, Optimized and Proxy.

A note on drag and drop

It can be tempting to use drag and drop to import directly from the finder. If you do use drag and drop, the above import menus do not appear and Final Cut Pro uses the preferences dialogue to specify storage locations which normally reflect the last chosen setting but it is good to double check as this can lead to files in odd places.
Storage Locations

It is vital to set storage locations at the beginning of your job but this can be changed mid job and is an essential control when performing media management tasks.

![Set storage locations for the library “Mount Fuji”.](image)

In this case (default), incoming media is directed into the library - this is termed “managed” media.

![Set storage locations for the library “Mount Fuji”.](image)

In the above case, any incoming media is directed to an external location (FUJI MEDIA) - this is termed “external” media.

The four sections in the dialogue above are as follows:

1. **Media** - includes Original (camera media or files), Optimized and Proxy. Can be set to almost any location, including inside library, shared or network drives. This will be the large majority of your content.

2. **Motion Content** - Content created in Motion and exported as Templates. If not careful, this can be left behind when sharing libraries, so this menu allows these to be saved inside the library (or in a shared location). It is safe to leave this as default (in the Movies folder) if working solo, but if collaborating make sure it is somewhere accessible to everyone.

3. **Cache**. These are render files, audio waveforms, thumbnails and analysis files created to facilitate efficient performance. These are all small files, need a fast drive and do not perform well on RAID and some network storage. They can be stored inside your library or external but can become quite large hence many people use a dedicated external drive. An SSD would be a good option. If an external location, a special bundle will be created (seen to the right). These files can be recreated so it is not something to keep at the end of a job.

4. **Backups**. Auto-saved copies of your library. Should be saved on a drive separate to your working library (in case of drive failure) - default is on your local drive so this should be changed if library is local too.
Importing - Copy to or Leave files in place?

This little section of the Import dialogue, represents a vital choice in regard to managed/external media. There are two options: Copy to & Leave files in place.

Copy to (Copy files to)
This option always results in media being copied to the location set in Storage Locations.

In this case, the default option (“Copy to library”), results in files being copied inside the library (i.e managed).

Modify the library Properties to a folder or drive external to the library and the “Copy to” dialogue changes to reflect that location (in this case, FUJI MEDIA).

Leave files in place
This option, results in no copy being made and simply links to already existing files.

This will always result in external media and is more appropriate if media has already been ingested and not available if importing directly from a camera card.

Import from camera card vs Import from drive
The “Leave files in place” option is greyed out when you access a camera card, forcing you to copy files.
This is a Final Cut Pro safety mechanism preventing you from linking directly to files on a camera card when importing.

This avoids the potentially embarrassing situation where you import, then send the camera card back to the camera with the only copy of the media still on the card.
Managed vs External Media

These two terms do not appear in Final Cut Pro but are used widely to describe and understand two different scenarios. They are not different file types but are defined by their location relative to the library.

**Managed media** is stored INSIDE the Final Cut Pro library.

**Pros:** Everything in one place. Very easy to control, save to another drive or archive. Very little chance of media becoming offline.

**Cons:** Library package can become large, so not good if you need to share or move your library quickly. Accessing media from outside the library is more difficult. Relies on your library and media being stored in the same location, which may not be ideal.

**External media** is stored OUTSIDE the Final Cut Pro library.

**Pros:** Libraries remain manageable size; much easier to move, copy, archive and share. Allows different choice of storage for media and library. Allows easy access to media for other applications and users. Media more easily shared with other Final Cut Pro libraries (and users).

**Cons:** Library and media are stored in different locations and therefore more likely to become disconnected, moved, modified or deleted.

In the below example, lets say we had 100GB of media to ingest (import), if we choose the library as storage location (option 2), we get a library size of 100GB, whereas if we choose an external location (option 1), we get a very small library, (typically a few MB in size). The smaller library is much easier to share, move, copy etc.

Now we are clear about managed and external media, we consider library and media storage options together for a single user. There are four options detailed below:
Library and Media Storage Options - Single User

1. Managed (Media)/ Local (Library)
e.g. everything on a laptop.

Pros - Safe and secure - everything in one place, inside the library. Perfect for editing in the field. Good for proxy workflow.

Cons - Space limited to internal drive. Playing media from the boot drive will add extra load. Not so easy to send a copy of the library due to size.

2. External Local (Media)/ Local (Library)

Pros - Very versatile - no external drive needed. Can take on the road. Easy to offload, archive or share media.

Cons - External media requires extra media management.

3. Managed (Media)/ Drive-based Library

Pros - Safe and secure - everything in one place, inside the library.

Cons - Performance limited by connection to and speed of external drive. Also less portable.

4. External Drive-Based (Media)/ Local Library

The classic set-up, that most larger outfits will be using.

Pros - Very versatile. Splits load between drives - external (media) and internal (libraries) may yield the best performance plus extra storage space.

Cons - Requires extra degree of media management. May not be as fast as local drive depending on storage type.

A main premise of this paper is that shared media should almost always be External (denoted henceforth by the curly red arrow), indicating that clips are referencing media outside the library.
Importing Strategies

There are many tools for importing/ingesting and Final Cut Pro is just one.

People use different apps for different reasons, too wide to detail here, however one thing is sure: keep it consistent and simple, decide on your regime and stick to it.

A common procedure is to make copies of camera cards onto back-up storage, then import just the files you need into Final Cut Pro. This leaves a full archive on your back-up. Some users may import everything, others may use the import dialogue to choose certain clips and portions of clips.

Third-party apps may be camera-specific plug-ins, media asset managers or standalone apps specifically designed for just this purpose (like Edit Ready, Hedge or ShotPutPro for example).

Storage Hierarchy

Whatever method used to copy camera originals, (and other files), a coherent system is vital. Many people use a centralised folder system to hold media and all documents for a specific job.

This allows everything for any given client to be moved, copied or archived using one folder. In the above, Client XXX is a template folder that can be copied and adapted for a new job.

The excellent freeware app PostHaste from Digital Rebellion allows you to generate a folder structure like the above based on criteria that you set, and can include a template FCP library with preconfigured events and keywords.
Camera archives

A Final Cut Pro only option would be to create Camera Archives from within the import window and then import from those. A Camera Archive is a secure read-only copy of the camera card that behaves just like a camera card with the added benefit of allowing multiple cards to be mounted at once allowing spanned clips to be imported as one.

1. All files copied from camera
2. Import only required files

File naming

The Final Cut Pro import dialogue is simple, fast and safe, however one thing it lacks is the ability to change the names of files/clips on import or at any point afterwards.

Many applications do allow renaming of files on import. Renaming files is an excellent strategy for workflows in which the imported files become the masters, avoiding the ubiquitous Clip 0001 scenario which can lead to confusion if clips need to be relinked from large media pools.

There are many applications that facilitate this, from the simple (my favourite is Edit Ready) to full-on MAMs (Media asset managers.)

There are some scenarios where you may not want to rename files; for example when file names have been part of a complex logging procedure or when using cameras that produce their own proxies such as Red and Arri.
System Performance

One of the holy grails of editing is smooth and seamless real time playback and Final Cut Pro does a very good job of prioritising this however it is useful to know what the software achieves this.

Final Cut Pro on MacOS, running on Apple hardware using an Apple codec (ProRes) is a hard combination to beat, but all systems have limitations and it is helpful to know the potential causes and remedies of any issues. Whether it is your media, your computer, your hard drive or your software settings, Final Cut Pro has several tools to help diagnose and then deal with performance issues.

Dropped Frames
If your computer system is reaching a limit in terms of real time playback, Final Cut Pro will skip frames to maintain real time playback. This is termed “dropping frames” and is entirely intentional behaviour but important to understand.

Dropped frames are mainly caused by two factors:

1. Slow computer - Depending on your system, dropped frames can be caused by your GPU, CPU or other hardware not being fast enough to playback all frames in real time. This can be due to effects, graphics or titles added to your timeline or simply the media format or resolution.

Let’s look at the playback preferences; below are the default settings.

The above option (in red box) relates to computer speed. The default preference is to allow dropped frames in favour of real time playback to allow you to go on editing. If you tick the box however, Final Cut Pro will stop playback and warn you every time frames are dropped (this is best used as a diagnostic if you suspect frames are being dropped).

2. Slow storage - If your storage speed (or connectivity) is not fast enough to provide all the data needed for real time throughput, it will drop frames. The default option is to warn after playback.

Slow storage may be remedied simply by using faster storage but may also be a symptom of a more complex issue such as having non-optimised files stored on your media drives.

If you do detect dropped frames, there are several options.
Quality
If your system is dropping frames due to media size or format, you can go down a gear in playback quality using the View menu. The default is Better Quality; Better Performance will give you more chance of real time playback.

Better Performance reduces the resolution of playback but doesn’t affect render or final export quality). It is accessed in the View pop-up menu at top right of the viewer.

Rendering
If you have adjusted the clips in your timeline at all: resized, added effects, multilayered, speed-ramped, used optical flow, noise reduction, other frame analysis tools, added Motion Templates or any third party effects, it may be you simply need to render in order to get playback. By default, background rendering is turned on; many people turn this off and only render when needed. Once rendered, render files play in place of the adjusted clips in the timeline.

Use Generated Files
Generated files are created by Final Cut Pro and help with the performance of the system.
Generated files are made up of optimized, proxy, render and cache files.

Cache Files
Created automatically in the background, these files help streamline Final Cut Pro performance. Waveforms and thumbnails are tiny files used to draw media representations in the Final Cut Pro GUI. Analysis files contain metadata about scans done on media as well as optical flow data.

These files do not affect playback directly but can affect performance in general, especially when being created (importing media for the first time). Their default location is in the library however they can increase in size significantly and are best saved in a fast location, away from your standard media.
Optimized Files

Optimized files can be one solution when your computer is struggling to playback certain media types especially long-GOP or RAW files (such as H.264, HEVC, mp4, R3D). Optimized files are ProRes copies of your originals at the same resolution but require much less decoding thus allowing smoother playback. The downside is a larger file size so drive space and speed will need to be taken into account. Optimized files are created on import or later from the File>Transcode menu.

In the majority of cases, Optimized will be ProRes422 but with RAW camera files (such as R3D), Optimized will be ProRes 4444 allowing a deeper color space for grading and also alpha channel if needed.

ProRes is a capture, mezzanine and finishing format designed by Apple. ProRes 422 is a 10-bit (12-bit with ProRes 4444), i-frame only codec, designed to allow full finishing functionality within Final Cut Pro including color grading and effects. Although technically a lossy codec (nearly all codecs are), the picture quality across multiple generations has been proven to be incredibly robust.

See this Apple white paper for more info about ProRes.

Optimized is a great solution for jobs such as 4K multicamera edits in which multiple files need to be played back at once. For this reason Final Cut Pro has a default preference to automatically create Optimized media for multicam clips.

This can take up a lot of space. Imagine a 60 minute concert with 10 angles of HD. Creating Optimized media for this would equate to something like 600GB extra media. Make that 4K and you’re looking at terabytes of space.

If they exist, Optimized files are used automatically by Final Cut Pro in place of originals (but the originals remain). You can see from the view menu if Optimized is being used on any particular shot.

Optimised is a very useful function in the right scenario with possible downside being time taken to create and drive space used. The alternative is to use proxies.
Proxy Files

Proxies are lower resolution video files that take up much less space than originals. They can replace originals temporarily to enable playback on less powerful systems or transfer to remote systems. Local proxies are most useful when storage or computer processing is too slow or small and remote proxies are useful if exchange of full resolution media is unfeasible due to size/distance.

Just like optimized files, creating proxies is done either on Import or from the Transcode menu.

There is a choice of two formats: ProRes Proxy or H.264 discussed below.

Note that proxy is a video only function; audio and still frames are not transcoded into proxies.

Choosing proxy playback is a single click in the Viewer and gives three options: Optimized/Original, Proxy Preferred and Proxy Only.

Proxy Preferred will use Proxies if present, otherwise original media is used. eg. if a particular format is causing problems, create Proxies for that format only and Final Cut Pro will use those along with the original files for all other media.

Once selected, Final Cut Pro tells you conveniently if a clip is accessing a proxy file in the viewer.

Proxy size and format?

There are two choices of format for proxies in Final Cut Pro: ProRes Proxy and H.264 with many sizes available. ProRes yields better picture quality and color fidelity, but takes up more space; H.264 has the advantage of being way smaller. H.264 allows you to distribute what could be terabytes of media in a few hundred gigs, whereas ProRes Proxy will give you more a consistent color and effects workflow because of its superior codec. If you are doing a rough grade, ProRes would be best but if media size is key, H.264 will give you incredible efficiencies.

If using HDR video, Final Cut Pro will throw up an alert if you try to use H.264 and it will choose ProRes Proxy. You can, however, use Compressor to make HEVC proxies and then relink these manually (see Chapter 2).
Comparing Sizes: Original, Optimized and Proxy

In terms of file sizes, have a look at these three 8K RAW Redcode files (taking up 5.5GB of space) transcoded to three formats:

- Optimized (ProRes 4444)
- ProRes Proxy (25% size)
- H.264 Proxy (12.5% size)

The optimized files are more than double the size of the originals (but a lot easier to playback and quicker to render); the ProRes Proxy at 25% is substantially smaller and the H.264 at 12.5% (540p) is almost 1000 times smaller than the originals and more than ten times smaller than ProRes Proxy.

If this was terabytes and the original was 5.5TB, our proxies would be roughly 73GB (ProRes Proxy) or 6.4GB (H.264), enabling very easy transfer to a remote editor in a proxy-only library (see chapter 2).
Doing a bit of pixel-peeping, here are the native 8K and 12.5% (540p) files zoomed in (massively) to compare detail and the full screen proxy shot for reference - the proxy even at 12.5% is more than enough for focus quality offline and 1000x disk space saving is immense.

To the left is the full frame H.264 (12.5%) proxy of the 8K shot for reference.

The ability to condense Proxy media into such small file sizes creates huge versatility in terms of shared workflow as can be seen in the next chapter.
Chapter 2 - Sharing Work in Final Cut Pro

There are many definitions of shared work and an almost infinite variety of set-ups however there are two clearly different scenarios that require different treatments as below.

**Shared media**

![Diagram of shared media](image)

This involves users connecting to one repository of shared media. Users can be in the same building or even in the same room, or hundreds of miles apart. Media can be on a server or in the cloud. The main bottleneck will be the connection to the media and there are hugely varying speeds in both local systems and remote, mainly varying with cost.

**Remote media**

![Diagram of remote media](image)

This involves users obtaining and maintaining their own copy of the media and using whatever means to share their work, (almost certainly on the internet unless they are working at the top of a mountain).

There are two discrete divisions here: a central transfer repository (ie the cloud) or users sending work directly to one another.

There are many variations and combinations of these options, (eg shared master media and remote proxies) but the two systems of media storage remain constant and will be referred to as such in this document.

**The Tools**

The tools relevant to shared workflow and media management in Final Cut Pro are all found in the File Menu: Copy, Move, Relink, Consolidate, Merge Events & Import/Export XML (Transcode was dealt with in the last chapter). Most of these functions can work at clip, event, project and library level, offering huge possibility for shared working as discussed on the following pages.

Also discussed, are two highly useful workflows; the Transfer Library and the Proxy-Only Library, both of which play a large part in the workflows illustrated in the latter part of this chapter.
The Tools - Copy

Copy is one of the key tools for sharing work and media across libraries and users. This function is hugely versatile and a thorough understanding is essential for any advanced workflow.

You can copy clips, events, projects or even entire libraries to a chosen destination library. Drag and drop items or use the copy function in the file menu. What you have selected, will determine what is copied.

Libraries
If you have a library selected, the whole library will be copied, arriving at the selected destination library as separate events named after those in the original library.

In this case, the entire library “Thursday Morning” will be copied to “Mount Fuji.”

Events
With an event selected, just that event (and its constituent assets) will be copied.

Clips
With individual clips selected, just these will be copied into a new event named after the date.

Projects
With a project selected, just the project will be copied into a new event named after the date.

A note on multicam and compound clips

Due the nature of multicam and compound clips and their relationship to the underlying master clips, you should transfer projects with any multicam or compound to their own event before copying across libraries (whether using XML or copying directly); this ensures no clips are copied resulting in lots of duplicated clips.

As a general rule, it is quite good practice to keep projects in their own events anyway.

Take care
Copy is one of the few functions in Final Cut Pro that can affect both clips and files at the same time.
If you copy an event to another library, you get an event and everything in it including any projects. Below we see the event “Lockdown Images” being copied from Saturday AM to Thursday Morning.

All metadata (keywords, markers, roles etc) follow along to the destination library.

**Drag and Drop**

If you want to copy just a project from one library to another, targeting an existing event, you can simply drag and drop and just the project is copied across to the targeted event. (Note the green copy icon)

Note that an important difference between using the copy function and drag and drop, is that with drag and drop, you can target an existing event, whereas copy will create a new event for the new project. Drag and drop can save time and prevent confusion arising from multiple, essentially redundant events.
To replace an updated project, see the XML workflow later in this chapter.
Whether, how and where media is copied is controlled by the following menu (below).

[Diagram of menu]

This first menu chooses if media is copied. Followed by a list of the three media types.

This box determines whether external media is copied and is a vital function for shared workflow.

This determines the destination for the copy and initially is set to the same as in the library properties menu but can be changed.

If you choose “event without media” (or library/project without media), no media is copied and the result is missing media at the destination; this can easily be relinked to other media e.g. third party created media.

[Diagram of menu with event without media selected] With “without media” selected, media options are greyed out, as you would expect.
The Tools - Move

The Move option is similar to Copy, but less versatile and perhaps more dangerous. Managed media is always moved but external files are not included in the move. If there is only one event in a library, you cannot move it. Move would most likely be used when organising or archiving work rather than in the middle of a job as the clips and everything associated with them are removed from the source library. I rarely use this function, whereas “Copy To” is essential for many shared workflows and totally non-destructive.

Move can be destructive and will affect the library you are moving assets from - use with caution.

The Tools - Relink

If files are missing or indeed still online; they can be relinked from the file menu. Original and proxy media can be relinked separately and can have a different resolution and codec than the original files, and can be trimmed versions of the original files, but must include all media in used clips (ie those used in a project).

In addition, relinked files must share the following qualities with the original files:

- Same media type (ie, video or audio)
- Same frame rate
- Similar audio channels

Online files can be relinked; for example if replacing watermarked files from a stock footage company with purchased full resolution files; just chose Relink> Original Media and point to the folder with the new files and if they have the same name, they will relink automatically.

Proxy relinking is now possible independently from the main/original media and is the same process but choosing Relink> Proxy Media. This allows externally created files to be relinked as proxies (ie using Compressor or even using camera proxies. Note that original media must have been imported to the library first in order for the proxies to connect however the originals do not need to be online, in other words the clips must already exist in Final Cut Pro before proxies can be relinked.

If relinking a large amount of clips, the ideal situation is to have the same folder structure as the original files as this is remembered by Final Cut Pro. Even if the main media folder is in a different relative position on the drive, all you need to do is select clips to be relinked, point to main folder in the relink dialogue, find one file and Final Cut Pro will do the rest.
The Tools - Consolidate

Consolidate gathers media files together for a library, event, project or even individual clips.

Consolidate will move or copy underlying files to the destination set in library properties. It is an essential function for shared workflow. Media inside a library gets moved out during consolidate but external media is copied.

Consolidating is simply the process of moving all files to a single location, whether that be inside or outside a library. It can be done for Original, optimized and proxy files.

You can consolidate events, for example to send all media for a particular scene to one location or an entire library as seen here.

**Consolidate library**

You can consolidate a project, for example at the end of a job, you can copy all the files to a single location for either finishing in another suite or simply for archiving.

**Consolidate project**

When consolidating media, make sure to also consolidate any Motion Content used so it doesn’t get left behind. Motion Content is bespoke graphic content created in Motion and not present in Final Cut Pro by default.

Consolidating Motion Content can be done in library properties or the file menu.

(\textit{Note this is not a way around paying licence fees for commercial plug-ins}).
The Tools - Merge events

Merge events does exactly what it says. You start with two or more events and merge them into one event containing all clips and metadata from the original events.

Here is a simple example using keywords. You are working on the football league and your assistant has collated all players into keywords for each team and divided them into events. When two teams meet, you want a library with just keywords for these two teams. This is how you might use merge events to achieve that.

1. Select teams from Teamsheets library

2. Copy events to new library

3. Merge events (in new library)

4. Result - One event with all metadata

Note; There are other ways to do this. This is just one example. Merge events can of course also be used for events with media as well as without.
The Tools - XML

The tools inside Final Cut Pro are now so versatile that XML is less needed, however it is a great tool to have in the box and is especially useful when exchanging work remotely due to its minimal file size.

If you choose File> Export XML, it creates a small file that people generally refer to as an “XML”. These files use a text-based language (FCPXML) not unlike HTML that allows elements (libraries, events, projects, clips, metadata) to be transferred between users and applications.

Typical uses would be sending projects to/from sound mix or color grade. Rich metadata allows for all sorts of clever uses from media asset management to transcription and film turnovers. A quick look at Final Cut Pro in the App Store will give you some idea of the breadth of uses but there are some specific applications useful for shared and remote workflow in Chapter 3.

Third party apps can send clips and other data to Final Cut Pro in the background using XML and can embed URLs into XML so they can tell Final Cut Pro where clips are, without having to relink.

A detailed example of XML workflow is shown on page 40

Note: XML exchange works fine with most projects, however some complex settings (especially from third party plug-ins) may not be carried across, so make sure to test and always bear in mind some information may be lost.
The Tools - The Transfer library

The transfer library is not an official function within Final Cut Pro but a concept used widely by users. In most of the workflow examples in this paper, work is exchanged using transfer libraries. Whether two editors in adjoining edit suites on two halves of a TV programme or a collaborative social media team distributed around the world, the principle is the same in both cases.

A transfer library is an exchange hub for Final Cut Pro users for the non-destructive exchange of work (not media). Users send events, projects, clips and even whole libraries to one another, using the transfer library as a hub.

The basic idea is that User A has their own library open and either creates a new (transfer library) or opens an existing one and uses the Copy To dialogue (or drag and drop) to add elements from their own library to the transfer library; this could be logged clips with range-based keywords and favourites, whole events or actual projects. If working back and forth, teams can choose to work with just one single transfer library and add assets to different events on each copy, or alternatively create a unique library for each copy and when finished, simply delete it.

Shared environment

In a shared environment (above) the transfer library would normally reside on a server. When finished copying, User A simply closes the transfer library and User B opens it (from the same folder) to copy the new elements to their own library. As of 2020, network mounts that support opening libraries are currently SMB or NFS mounts.

Remote environment

With remote working (above), User A would send the transfer library to User B via email, cloud or even ship a hard drive and then the process would be the same.

Generally no media is stored inside a transfer library as this complicates things and increases its size making exchange less efficient. Another important note is that transfer libraries are disposable. Nothing they contain is unique as it has all been copied from another library.
The Ultimate Transfer Library

With Final Cut Pro X 10.4.9 came the ability to copy an entire library into an already existing library or to an entirely new library from within Final Cut Pro.

In many ways this may be the quickest way and certainly safest to copy everything.

What results is all the events from the copied library are copied across to the destination library with the original library left untouched. The downside of this is perhaps you get too much information and in a shared scenario, lots of potential duplicates; however there will be times when this is very useful (copying an archive, picture or music library); or effectively merging two libraries into one.

Copying a library: events from imported library appear in the destination library.

In a shared media scenario, external media files should not be copied and the new library will automatically point to the existing media.
The Tools - Proxy-Only Library

Like the Transfer Library, the Proxy-Only library is not an actual function or menu item in Final Cut Pro; however it is an invaluable workflow option which opens up a huge range of possibilities.

A Proxy-Only Library contains only proxies. It allows work (and media) to be exchanged at much lower file sizes, enabling more efficient transfer, storage and playback on lower-specced machines. (e.g. you might be able to store and playback proxies representing several terabytes of 8K media on the internal drive of a MacBookPro).

Here are some typical steps to create a proxy-only library with managed proxies (ie proxies inside the library)

1. Select your library (or an individual event or project). Choose File > Transcode Media to create proxy files at the desired size and format.

2. Choose File > Copy To > New Library, name and save it. (If the library is for sending to someone via a physical drive, you could choose that drive as a location.)

   Copy media stored in external locations ensures everything gets copied irrespective of where stored.

3. Click OK and the new library opens in Final Cut Pro. To view proxies you may need to select Proxy or Proxy Preferred from the Viewer pulldown menu.

Proxy-Only Library Notes

In the above, we have Media Destination set to “In Library” so an entirely self-contained “managed” proxy-only library is created. This can be transferred in one go with no danger of anything going offline; perfect for transfer to a hard drive or laptop. For shared media however, there is no need to duplicate the media.

External media storage would be a better option for cloud-proxy exchange where it is prudent for library and media to be kept separate.
If there are any files with no proxy, Final Cut Pro will flag this up for you and offer to create them if you click transcoding.

**When to create proxies?**

As soon as you know you need them and as early as possible to allow you to plan. You don’t want to do it twice, so do some calculations; use a fraction of your media to test timing, space, picture quality and playback before you set about transcoding many hours.

Note that raw files, such as RED, will have their raw camera settings “baked-in” when proxies are made so it might be wiser to create the proxies with a basic “one-light” grade or a LUT.

**Where should I put my proxies?**

It is possible to create proxies almost anywhere you want. You’ll need your original camera files first, to create the proxies but then you can make a proxy-only library without the original files being online.

As long as everything is controlled from within Final Cut Pro, we can send proxies anywhere we want and maintain the links to the original files - this is the key to a successful workflow. Do it all from inside of Final Cut Pro - essentially using Final Cut Pro as a MAM (Media Asset Manager). Almost everything done to the proxy clip inside Final Cut Pro will automatically transfer to the full quality originals when relinking.

**Non proxies**

Some files, such as audio and stills do not get transcoded as proxies so Final Cut Pro uses the original files. When creating a proxy-only library or moving proxies anywhere, Final Cut Pro now tracks these “non-proxy” files and makes sure they are included when media management is performed. This makes it a very simple process and Final Cut Pro guides you through it with very clear menus.

So those are the tools, let’s look at them in action; first with shared and then remote media.
Shared Media

Let’s start with the straightforward option of multiple users sharing media on centralised storage.

The classic boutique set-up below would involved typically 4 to 50 users but most small workgroups would be up to about 10. A perfect option for a medium-sized agency. These set-ups come in various flavours and will probably require IT support whether that is in-house or a supplier.

Traditionally this would have been Apple’s own XSAN but there are now many options that perform a similar function. Speeds vary depending on configuration - see page 43 for a discussion of the merits of DAS, SAN and NAS.

This set-up (diagram simplified) would typically be onsite at a facility, TV or production company but several solutions offer remote log-in to set-ups like this such as the Lumaforge Jellyfish.

Use external media for shared set-ups. In all our shared scenarios, we assume media to be external to the library. This was discussed in regard to single-user set-ups and is even more important when sharing.

The ingest department, if using Final Cut Pro, copy media to the central storage creating external media. Users then import using Leave files in place, creating links to external media.

Below are four examples of using transfer libraries on shared storage with shared media:
Shared Media Example 1: Programme Stitch

User A and User B are sharing an edit using shared media. User A wants to send their half of a programme (project A) to User B, who will stitch it together with the second half (project B).

User A selects their edit (project A) in their own library and chooses “Copy Project to Library”, selecting the transfer library (Transfer Lib TOTP) as the destination.

The result is project A is copied to a new event in the transfer library called 22-10–2020 and the media is relinked automatically because they are using the same storage.

Once done, User A closes the transfer library, notifies User B and continues working.

User B then opens the transfer library, selects project A, chooses Copy Project to Library and targets their own working library (User B). User B now has the two halves of the programme and all they need to do is copy and paste project A at the beginning of project B and press play.
Shared Media Example 2: Logging

User C is cutting away, when the producer requests archive footage integrated into the programme. User C asks assistant (User D) to source the archive, mark out the best shots and send it across.

**User D**

User D imports some archive shots onto the shared storage (1) and marks out the best bits using keywords and favourites (2). When done, User D selects the required clips, chooses “Copy Clips To library”, targeting “New library” and calls this “Archive007” (3).

A new library called Archive007 with an event containing the archive is created on central storage.

**User C**

User C now opens Archive007 (the transfer library) and copies the event to their own working library (4).

For a longer set-up, User C could leave Archive007 open and drag clips across when needed.

Things are made very simple because no media needs to be copied. All media is shared external.
Shared Media Example 3: Live logging

If working on a live stream where editing starts before the stream has finished (e.g. a live event), the editor relies on an assistant to log the footage as the event progresses. User E starts editing with the live (growing) feed from a source (like MovieRecorder from Softron) directly onto the shared storage. In another suite, User F logs the feed with keywords, favourites, markers. 15 minutes in, User E wants to add the metadata to the existing clip without duplicating. Effectively they want to replace it with the same clip but with newly logged data.

An alternative option - XML

The above scenario is messy and can be remedied by deleting the older versions of events however there is a better solution. We mentioned XML earlier and this is a good example of where it makes things easier.

Rather than deleting assets, (always stressful, let alone when live), User F exports an XML of the event containing the live streaming clip with updated logging data. On import of the XML, User E can replace their existing feed clip with the one with current logging data and continue working.
Shared Media Example 4: Breaking Down Work

In this fourth example, let’s say a series of cookery programmes, imagine the assistant editor brings in all the rushes using one big main library and arranges it into episodes; they also use this library to catalogue music and graphics. This is a nice way of keeping everything centralised.

Once everything is divided into events, those events are then copied into individual libraries in a transfer folder that individual editors can then access. All the work has been done for them so all they need to do is copy their allotted episode library to their own computer and start editing. If they need any clips from other episodes, they just copy that transfer library to their own side.

If anything needs to be stitched together at the end, they just follow the workflow in example 1 (above).
Shared Library Storage Options

We’ve already discussed single-user storage options in chapter one, but with multiple users, comes added complications. Whilst manufacturers (and users) tend to focus on fast media access and playback speeds, it is easy to overlook where to save your libraries (databases) and this oversight can cause some big slowdowns. So where to save your Final Cut Pro libraries? A tempting answer is in the same location as the media, however this is often a bad idea unless shared storage has been optimised.

When working with video we can generally break files into two categories: data (small) and media (large). Media files are your raw material, video/audio/stills/photos/graphics. Data includes your libraries and cache, both of which are packages as discussed, which when working, process a constant stream of data. This data behaves very differently to media and both can get in each other’s way (and therefore hinder performance of Final Cut Pro).

I must give credit to my good friends at 10dot1 for the following cycling metaphor to describe the movement of data and files in XSAN (which can apply to many other types of complex file system).

Cycles (small files) are impeded on a busy road of cars (big files). Cycles are fastest in a dedicated cycle lane. Conversely, cars are obstructed by cyclists and there is also no speed advantage in driving a Ferrari down a cycle path. It is in everyone’s interests these two traffic streams (data and files) are separated.

Generally you can break media storage into three types DAS, NAS and SAN.

DAS or direct-attached storage are usually plug and play drives (e.g. Thunderbolt drives). They have many flavours: the more expensive and scalable may be RAID striped for speed and redundancy but this striping, although clever generally doesn’t play as well with Final Cut Pro libraries as a simple SSD drive attached in the same way. (Try opening a complex library from your super-fast RAID array and compare the speed of opening to that of an SSD).

NAS is network-attached storage in which files and data travel within a distributed file system (or network). Both storage, servers and networks vary widely however and while 10G ethernet allows good bandwidth for media, data still needs to be read and written as quickly as possible. Not many NAS systems are likely to compare to the proximity and speed of an internal SSD for database activity, in short, it is likely best to keep working Final Cut Pro libraries local if possible. Some hybrid NAS solutions offer centralised segmented drives or partitions optimised for small files so do your research and make sure you go for 10G.

A SAN or storage area network, (of which XSAN is Apple’s own version) is an intelligent storage system with dedicated metadata server, while large media files are distributed through fast fibre connectivity. SAN storage optimised for media does not perform as well with small files as a local drive. In a nutshell, keep your libraries off a SAN if possible (perhaps consult the IT department to see if there is a storage pool that can be used for databases.)
Basically, avoid any form of complex storage for Final Cut Pro libraries if speed is your priority. If your library is fairly simple and shared connectivity is most important however, then central libraries may be a good option.

Some storage solutions (such as the Lumaforge Jellyfish) have an optimised cache designed specifically for the storage of production files such as Final Cut Pro libraries. These are great for collaboration between editors who don’t want to constantly move libraries around and can be expanded to many terabytes; however they do lack the direct connection of a PCI-e connected flash drive and do come at a price.

Be careful with some out-of-the-box drives. There is little point buying a Thunderbolt-connected drive with a spinning disk inside; also be aware that USB-C and Thunderbolt 3 are not the same. Many two disk RAID solutions, whilst very fast, have no redundancy whatsoever and are essentially doubling your chances of disk failure.

Finally on older computers, if your local drive is a fusion or a spinning drive, this will very likely be your bottleneck and not your best option for Final Cut Pro libraries. If you do have an older Mac, you may wish to invest in an external SSD with fast connection or even upgrade with an internal SSD.

As discussed for single users on page 18, here are some pros and cons for shared storage.

**Shared storage local libraries**

Pros: Local libraries keep things tidy with no ambiguity about where work is stored or who it belongs to. Local PCIe-attached SSD storage (on modern Macs) is likely to be much more responsive than any centralised storage and the small extra time to copy from central to local will usually be easily compensated by increased speed and responsiveness of Final Cut Pro.

Cons: Need to copy or move libraries to collaborate or share with others or move edit suites.

**Shared storage centrally-stored libraries**

Pros: The classic set-up for collaborative workflow where editors swap, transfer and copy libraries (or events) in one central location. A perfect example would be a huge media archive shared by everyone. Only one version of the archive exists, so no confusion between users.

Cons: Can get very confusing tracking which libraries are current and editors must coordinate to ensure everyone knows who has got what library open. Each team will have working practices for who owns which libraries and how work is exchanged but it can get messy. Aside from that, the speed issue discussed above is critical to performance.
Cloud-Based Media
In its most pure essence, cloud-based workflow involves streaming media from the cloud and not downloading anything; so in terms of media storage and access, it is more akin to the shared media workflows discussed above.

If you replace the shared media storage we’ve just been discussing, with the cloud, you get a similar scenario. If you are lucky enough to have something like this running, the workflow is very similar to using centralised storage (which if you think about it, is exactly what cloud-based media is).

Use external media, keep libraries away from the cloud and zip them up to exchange on the server.

At the time of writing, unless you have a dedicated fast media cloud provider and pipeline, the cloud is unlikely to give satisfactory playback for full res media. Other more consumer-oriented cloud services are not geared for media playback but can be used for media exchange as seen in the next section and seem perfect for exchanging proxy media.

Remote Log-In
Logging-in to workstations and shared media silos at remote facilities has become very popular for obvious reasons in 2020 and there are a burgeoning number of solutions at different price ranges.

In terms of Final Cut Pro, the functionality is no different to standard shared media set-up so this document does not discuss remote log-in solutions.
Remote Media

We now come to working with remote media; ie shared workflow using dedicated local media copies. There are two elements to consider: remote media exchange (media) & remote work exchange (libraries).

Remote Media Exchange

There are basically two ways of sending media remotely: physically shipping it or using some kind of network or cloud. Network/cloud is usually preferable and faster for small jobs, but in some cases (e.g. huge file sizes or no network), drives may need to be shipped and can be more reliable. Alternatively proxies can be used for offline work or sent ahead as placeholders via net/cloud while a physical drive is delivered later.

Remote Work Exchange

Once media is in-place, editors use transfer libraries and/or XML in the same way as with shared storage; it is simply a matter of getting the information from one place to another. The actual process of exchange is virtually the same whether you are in neighbouring edit suites or on the other side of the world.

Keeping Media Online

Ideally all media remains online throughout the job as work is sent to and fro. This requires everyone to have an identical directory structure (file structure) and maintain it; then transfer libraries and XML files will automatically link to media as they are sent between team members. Different local user accounts can cause problems so the easiest method for keeping things online is to place everything onto external storage with the same name and directory structure - if these are identical they will automatically relink.

Zip It

Libraries are packages of files and data and some of this data could potentially go missing or become corrupted when crossing the internet. To counter this possibility, when sending libraries it might be wise to zip them up to protect their integrity. Zipping is as easy as right (control) clicking a library and choosing “Compress”. The resulting package should be no bigger than the original library and much safer to send.

This is also an excellent way to archive or save a copy of a library as a zipped file is a read-only item.

All the below workflows can be done with original media, proxies or a combination of both.
Remote Media - Physical Drive Clone

This is an old school method but very robust if procedures are followed. There are several options depending on the length of the job, the number of users and who will be doing the finishing. One of the benefits of drive swapping is that media storage architecture can be set-up to be identical across all users and once delivered, the media will all be online ready to start editing.

Whatever method is used for ingesting, an agreed system for storage and naming should be agreed upon and stuck to; in the event of missing or corrupted media, this will provide the easiest path backwards to the media originals.

In the example below, camera rushes are copied to main storage and then cloned to identical drives and distributed to editors. One editor (Edit 1) then imports and logs the rushes, organising everything into one or more libraries which are zipped up and sent to colleagues in Edit 2 and 3. All media is kept external.

All users now have identical media set-ups and can send transfer libraries to each other over the internet. As long as the drives have the same name and media is not moved, no relinking will be necessary. Editors could copy the media to their own faster drives if required but this is an extra stage and might need relinking if drive names are different.

Of course, the faster the drives and connections, the better the editing experience.

Once done, editors pass their work using transfer libraries back to the master editor (let's say Edit 1) who compiles everything together.
Remote Media - Physical Drive - Library Clone

This is very similar to the above example but the ingest person logs the footage (using Final Cut Pro) and breaks it up into different events or libraries before cloning drives including libraries and sending. All drives are exactly the same on arrival and editors can get to work immediately with no relinking needed.

The advantage here would be the ingest editor can define logging conventions (metadata, event naming etc) before sending out.

In this example, a proxy-only library could be cloned onto all the drives rather than the originals. This might facilitate the exchange of all media for a massive project (like a big documentary or feature film) on a simple hard drive. Once drives arrive, editing is ready to move ahead with transfer libraries or XML providing the exchange.

When editing is finished, users send transfer libraries back to the finishing editor who stitches final projects together using the now familiar “Copy To” dialogue or simple drag and drop.
Remote Media - Upload/Download

In this case media is transferred via network (internet, satellite or other fast media superhighway). The only difference between this and the physical drive scenario above is the media transfer method and potential relink at the other end; the resulting situation and subsequent work exchange is identical.

Unless storage locations have identical names and folder structures, relink will be necessary (a simple but extra step). Certainly a good practice is to upload media folders in their exact hierarchical format (using an app like Frame.io Transfer) and to dedicate an entire hard drive to a job with the same name as the original media source.

Once a library has file locations in its database, any further input of projects or events referencing the same media will not need relinking as long as the media is not moved.

This Upload/Download scenario would be a perfect way to share a proxy-only library.
Remote Media - Cloud Syncing

In addition to streaming media directly from the cloud which is a technique sure to increase massively in the coming years, the cloud can also be used as an exchange conduit, particularly suited to syncing proxies as illustrated below.

The main editor uploads proxy media to the cloud choosing an external media storage location (in the below example FUJI CLOUD).

The resultant library is then zipped up and uploaded to the cloud along with media.

Users at the other end, download the transfer library and unzip it, while proxies are automatically synced from the cloud to a local drive.

Most likely users will have to relink media on first opening the library unless file paths are identical. (Note this will need to be done twice if proxies and original media are involved because audio, still frames are treated as original media).

Note: It may be tempting to open libraries from a shared Dropbox or G-Drive folder but this may result in corrupted libraries. iCloud Drive will not even let you open a Final Cut Pro library for this reason. Best to zip them up and copy to local.
Remote Media - Using iCloud Drive

A nice feature of iCloud Drive introduced in MacOS Catalina, is iCloud Drive Folder Sharing whereby users can copy media to a shared folder, and it automatically syncs to the local drive of those you’ve shared with. This would be a perfect option for sharing proxies and also adding media as a job goes along.

In the example above, if FCPCloud was an iCloud Drive folder, shared with the team, once team members join the folder, the proxies automatically download to their local drive.

In addition to this initial upload, if any media was added at a later date to the folder, it would sync automatically with other users. (See “Added Media” below)

Remote Media - Extra Media

In all the above scenarios, it will of course happen that extra material will be added after the job has started. e.g. pick-ups, last minute graphics, titles, music and voiceover.

To track these extra files, keep an “added media” event and copy new clips here.

When exchange is necessary, the new “added media” event can be copied into a transfer library (using proxy or original media depending on workflow). The consolidate command will ensure all media is copied to the desired location. The library and media can then be sent to the other users.

Once media is downloaded, users can copy the “added media” event into their working library. If this is done using a syncing cloud folder, then media transfer should happen automatically.

Any added Motion Templates and plug-ins will have to be consolidated separately.
Remote Media - Hybrid Proxy/Physical Drive

Now imagine a mixed situation where the media is thousands of miles away but too large to send across a network. Let’s say a shoot in Alaska; the editor is in LA and it is unfeasible to upload the full resolution camera files via satellite.

The DIT (working on set in Alaska) ingests the camera masters, adds a one-look LUT, generates proxies and creates a proxy-only library and this is sent via satellite to the editor who starts pulling selects for a studio viewing.

Each day, the editor sends a library or XML back to the DIT who can link this all back up to show the director the progress.

When the masters arrive on a drive in LA, they can be relinked to the proxy-only library with a couple of clicks, which then becomes the master library.
Remote Media - Reconnect to Original Media

Once remote work is finished, the best way to return and reconnect a project to its original source library and media is to use the “Without Media” function.

1. Choose the project and name it something different to the original (if there was one).

2. Choose File > Copy To > New Library (or the original library if it is available)

3. Select “Project without media” as seen left.

When the online (full resolution) editor copies the project into their library, it will relink automatically with the original media.

That is the end of our shared workflow examples in Final Cut Pro. The next chapter deals with third party solutions to expand the possibilities further.
Chapter 3 - Remote Working: Third Party Solutions

After detailing the native tools available inside Final Cut Pro, we now look at some of the extra tools you can use to augment workflow. Most of these tools have tight integration with Final Cut Pro and some have their own extensions inside Final Cut Pro.

Frame.io and Final Cut Pro

Frame.io is a review and approval application that has become an immense productivity tool. I use it almost every day for client review, however it is rapidly developing as a cloud-based MAM (media asset manager) with best in class upload speeds.

By its very nature, Frame.io is all about shared and remote working but the last couple of years have seen big leaps in development. There are now several tools, with ever-expanding functionality; how to get the best out of these tools is worth looking at.

Frame’s upload speed is blazingly fast and its user interface is very client-friendly but one of its biggest assets for remote working is that it automatically creates proxies in the cloud which can be subsequently downloaded by users at a fraction of the time and space.

What follows is a quick resume of Frame’s main functions focussing on in Final Cut Pro.

There are four discrete interfaces between Frame.io and Final Cut Pro that allow various actions.

- Standard web browser
- Mac app
- Frame.io Transfer app
- Final Cut Pro Workflow Extension

The examples that follow are less detailed than the above workflows as they share much of the same functionality; we are just focussing here on how Frame.io works.
Frame.io in a standard browser

This is how most people first come across Frame.io; the browser-based online review tool. It has a comprehensive set of functions for review and approval, for in-progress or finished projects, including the ability to sync comments back to your Final Cut Pro timeline and version control.

Clips or collections can be uploaded, annotated remotely (by a producer for example) and comments downloaded into Final Cut Pro by editors.

Upload a timeline

Export a Final Cut Pro project (timeline) using a Frame.io share destination and you get various options including a choice of uploading the timeline as one piece or as individual clips (think dailies or selected takes).

All you have to do is make a selects reel, export that and those clips and the timeline are all shared with whomever you want.

This has many uses - sending clips to other editors or only marked clips to VFX artists or promo producers, sending just the clips required for a colour grade or even an archive at the end of a job.
Frame.io Mac App
There is a standalone Mac app called “Frame.io” which when installed, appears in your Mac menu bar and allows you to upload multiple files from the finder or add watch folders.

As an example, an assistant could ingest camera rushes, make a local archive copy and set this archive folder as a watch folder; the entire contents of the folder will automatically upload to Frame, preserving subfolder structure if desired - this is a great function for passing the rushes onto remote editors and maintaining the all-important folder hierarchy.

See workflow diagram later.
Frame.io Transfer Tool

This is another separate app which allows upload and download of multiple files, maintaining folder hierarchy, (allowing easy relink in Final Cut Pro.)

The Transfer Tool would be perfect for larger jobs with big batches of media, maintaining complex folder structures, (such as we discussed in remote workflows in the last section), using Frame.io as a hub for transfer from one computer to another and ensuring that relink is at most, a couple of clicks away.
Perfect for a large proxy-only library with external media for example.

This would also be a solid way of backing up rushes to a remote location (or even use Frame.io as a back-up option).

Frame.io Transfer Workflow

Downloads come with the ability to select the resolution.

Download files as..
- Original
- Proxy - Highest
- Proxy - Lowest

Same folder structure makes relinking easy
Frame.io Workflow Extension

This appears inside Final Cut Pro and allows access to your entire Frame.io library within Final Cut Pro.

Simply drag and drop clips into and out of the Frame.io extension.

Auto Proxy
If you select “Original” in the preference window (of the extension), on download, Frame.io will download proxies at the same time as the original and they will appear (as if by magic) as proxies in Final Cut Pro (if you flip the proxy button). I don’t like using the word cool when applied to software but this is indeed very cool.
Frame.io Proxy Workflow

As mentioned in chapter 2, external files can be relinked as proxies in Final Cut Pro which is essentially what Frame.io does in the background when you download clips. You just choose the resolution.

There are many ways to do this and circumstances will dictate which route is taken. Below is just one example.

1. Upload and proxy creation
Upload is done automatically (by the watch folder) and proxy creation automated by Frame.io. Proxies are downloaded using the Final Cut Pro workflow extension. Remote editor starts cutting with proxies in the normal way. The beauty of this is that only the media and proxies dragged across are downloaded, leaving everything else in Frame.io, which is essentially acting as a cloud-based media library.
2. Review approve

Remote editor and client/producer exchange notes and go through review/approval process using Frame.io in a browser.

3. Color grade & upload for final review

After picture lock/approval, remote story editor sends project (in a transfer library) to color grader who grades on full res media and uploads full quality version for final approval.
Postlab and Final Cut Pro

If you found the workflow choices in chapter 2 a bit overwhelming, and don’t fancy the idea of juggling transfer libraries; or are a producer or post supervisor worrying about whether your team are all following the same workflow and keeping things in sync, Postlab may be the solution for your team.

Postlab is a cloud-based app, that smooths remote collaboration between multiple Final Cut Pro users. Its main asset is the seamless syncing of work across multiple workstations/locations/users.

Essentially Postlab takes the transfer library concept and manages it in the background, using its own cloud storage, allowing users to concentrate on the (editing) job in hand.

In Final Cut Pro terms, Postlab works by syncing multiple users’ local libraries to and from its cloud storage, managing access and tracking changes. The idea is to use Postlab to open and close Final Cut Pro libraries, work as normal within Final Cut Pro (using local libraries) and then go back to Postlab to share your session.

Editors use the same Final Cut Pro tools described in chapter 2 to transfer work. Multiple users can work together safe in the knowledge that they are up-to-date and not overwriting anyone else’s work.
Postlab simplifies shared library management. It does this by “checking in” and “checking out” shared libraries so that you don’t have to worry who is working on what.

As long as users understand a few basic rules and have an internet connection, they can collaborate using Final Cut Pro with an extra layer of security and library version management built in.

Postlab manages library permissions and access via its central hub. Users can set status and send tasks to each other.

Postlab can be set-up on a shared media environment (in a production company) or remotely, with users accessing their own set of media (working from home).

Due to the nature of the Final Cut Pro library database, Postlab will not allow multiple users to work on the same library at the same time, however if required, users can make a copy of a library while someone else is working on it, access its contents and copy across to another working library.

In the example below, User B is working on the library so Postlab has locked the library for other users. Postlab will allow users to copy the library but changes to this will not be synced back to the main working library.
Postlab uses a “productions” paradigm whereby all libraries for a specific job/production are in the same folder which multiple users can access.

You can import existing libraries or create a new library in a production or use a template (for often repeated tasks).

When you do add a library, Postlab gives you an option of Individual or Shared.

If you are working remotely (with individual media copies), you should choose Individual; this way, Postlab will take care of any relinking necessary once you have shown the media path to Final Cut Pro.

The “Shared” option is for a shared media environment where all users are connected to the same NAS or SAN and a common media destination can be set.

Once set-up, it is important to use Postlab to open and close all libraries; this way it can keep track of who is doing what.

If a library is in use, Postlab will tell you and allow you to open a copy or force unlock (an emergency measure in case your collaborator has forgotten to “check out” in their rush for the door).
Postlab Drive

Postlab Drive is a cloud-based storage system offering responsive, low latency playback direct from the cloud. Drive is included with the higher tiers of Postlab with some storage included and more space can be hired if required.

Drive is activated from within Postlab and users need to be online to play the media as it is truly playing media back from the cloud.

Of course playback depends on your own network speed as well as the storage speed but Postlab will tell you if it thinks your internet speed is not fast enough.

Once Drive is online, you can then use it as a storage location in the same way as any other drive.

If bandwidth is low, Postlab can work using a local caching system which you can set to whatever size (and local drive) you want. Even if offline, the cache remains so you can edit with this media.

Users connect to one media location (Postlab Drive) making all media management issues and relinking a lot easier. One of the great current USPs about Drive is that once media is online, no relinking is necessary between library exchanges.

Workflows like this can only improve and Postlab Drive seems to be well ahead of curve in Final Cut Pro workflow.

Just In - Merge

Just hot off the press is Merge, which is a new workflow extension that comes with Postlab. This allows events and projects to be merged together, allowing metadata to be brought together from two or more sources.
XML Workflows

Final Cut Pro XML is primarily used for communications between third party apps and Final Cut Pro. A few key examples are below. Some people say some of these functions should be included in Final Cut Pro but most are only needed by relatively few people. Keeping these as third party solutions allows Apple to keep Final Cut Pro optimised for everyone.

Worx4X is an app you never knew you needed - until you did need it. It allows your media (with or without handles) to be trimmed down to only that used in your sequence (with some limitations on formats). Great for sending full res media to a color grade or for archiving at the end of a job.

Need to get your audio to ProTools? X2Pro is what you need. With a bit of preparation of your timeline, this app gets your audio into ProTools allowing the use of roles to define tracks.

The Lumberjack system is a set of apps that could save you days of logging time, whether on live, multicamera or existing footage. Of particular note for remote editing is the ability to log (keywords, markers, favourites) whilst watching any live feed (or indeed a live event), just using an iOS device (an iPad is best) and accurate time-of-day.

The log is then uploaded to the central Lumberyard app which can produce an xml file which can be imported into Final Cut Pro by any number of remote users with access to the feed. Several loggers’ data can also be combined into one.

Change List X is another app from Intelligent Assistance (makers of Lumberjack) that allows comparison of two Final Cut Pro timelines using XML. Back in the days of Final Cut Pro Studio, there was a companion app called Cinema Tools that allowed film turnover lists to be created for neg-cutting, sound mix, opticals and those inevitable last minute studio changes.

This kind of fills that gap but also has uses in the remote arena so two editors can compare work; especially useful at the end of a job where a lot of color, FX or sound work has already been done but needs to be incorporated the new cut. Another one of those apps that you never knew you needed, until you needed it.
**EDL-X** allows a classic edit decision list to be output from a Final Cut Pro timeline. It translates your sequence into the industry standard list format readable by most NLEs. Because it is simple, some information is lost, so this most useful for the offline cutting stage, where the finishing will be done on another platform.

**Davinci Resolve** is a color grading application (and much more) that accepts Final Cut ProXML directly. Of course media is needed too. As with everything, prior workflow testing will almost certainly save you time.

Recently announced is **Color Finale Connect** allows remote collaboration during a color grade in **Color Finale** (from within Final Cut Pro), even if all users don’t have the media. It uses an ingenious method of employing high res stills for the all important creative grade and bypassing the need for media exchange. If users are using Apple-only kit (including monitors) or a tightly calibrated monitoring system (slightly easier said than done), then color differences between remote stations should be minimal.

**Sync-N-Link X** is not strictly a remote workflow app but it is included in the film workflow below so I’ve included it here. It makes syncing of dailies and production sound a breeze using, you’ve guessed it, XML.

This could be a much longer list and there are no MAMs nor archive solutions here; these are some of the key players allowing shared or remote working. Check the Apps For Final Cut Pro page in the App Store [here](#).

**Closing**

I hope this paper has been useful. Apologies it is so long, if you’ve got this far, I sincerely hope you’ve learnt something.

Special thanks to Luke, Gorden, 10dot1, fcp.co, Bill, Patrick, Paul, Felipe, Philip, Emery and Estelle.

Good luck and thanks for reading.
About the author

I have an honours degree in chemistry from Imperial College, London, but decided on a career in film and TV a long time ago. My scientific training helped me to understand the physics involved in TV technology and I worked my way up from runner to editor in London facilities. Attracted by the freedom it offered, I took an early interest in FCP in 2002 which soon developed into a passion and I have since then, used FCP to cut feature films, work with the Sex Pistols and Julien Temple, edit and train at the BBC and supervise the FCP workflow at the FIFA World Cup in 2010.

I became an Apple Certified Trainer for Final Cut Pro in 2004 and in 2005, Apple asked me to be an industry mentor; since then, I have trained and qualified Apple Certified Trainers (in Final Cut Pro, Motion and Color) in the UK, France, Germany, Spain, Portugal, Sweden, Norway, Denmark, Czech Republic, Turkey, India and most recently in 2018, in South Korea.

I now produce, direct and edit across many media including virtual/remote/hybrid events.

You can see more about me and my company Slack Alice Films on my website.

www.slackalicefilms.com

Please get in touch for any advice.

Alex Snelling
December 2020